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1 Introduction

1.1 Welcome

Welcome to Summitsoft's Font Management System!

Thank you for choosing Summitsoft's Font Management System! - the easiest and most efficient
Font Manager. When it comes to designing Online or Print Projects, using the right set of Fonts can
create the desired visual impact. However, managing Fonts is not an easy task when you work with
hundreds, if not thousands of them. "How do I install them?", "Ho do I preview all of my fonts at one
place?", "Where can I store them?" - The Font Management System from Summitsoft Corporation
answers these common questions and more with easy options to install, preview, organize and
manage the fonts in your computer. Font Management System is the essential software to organize
and be in control of your fonts. Here are some of the key things that you can do with Font Management
System.

Easily manage your fonts.

Protect system fonts from accidental deletion.

Custom font preview allows you to type in your own text sample, and adjust its size and color.

One-click installation & removal of fonts.

Easy-to-use interface keeps you working quickly and efficiently.

Backup and Restore Fonts.

Preview Fonts before installing it.

1.2 License Agreement

READ THE TERMS AND CONDITIONS OF THIS LICENSE
AGREEMENT CAREFULLY BEFORE INSTALLING THIS
SOFTWARE. 

SOFTWARE LICENSE AGREEMENT

READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT CAREFULLY BEFORE INSTALLING THIS SOFTWARE.  
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1. Grant of License- This is a legal contract between you and Summitsoft Corporation.  The terms of this Agreement govern

your use of this program.  By installing this software, you are agreeing to be bound by this Agreement.  If you do not agree

to the terms of this Agreement, please immediately erase the software from your computer memory.  In consideration for

your payment of the license fee, which is your purchase price of the software, Summitsoft Corporation grants to you a non-

exclusive, non-transferable, limited license to use and display the software contained on this CD-ROM or Download File on a

single computer.  You may not copy it and give the copy to others to use or own, or use on a network.  Summitsoft

Corporation retains ownership and title to the software.  This Agreement is not a sale of the original program or any copy. 

The software is licensed only to you and may not be transferred, assigned, rented, leased, sold or otherwise disposed of to

anyone else.

2. Restrictions- The software is protected by both United States copyright law and international treaty provisions. 

Unauthorized copying of the software is expressly forbidden.  You may not distribute copies of this software to others.  You

may not modify, adapt, translate, reverse engineer, decompile, disassemble, or create derivative works based on the

software.  You may be held legally responsible for any copyright infringement that is caused or incurred by your failure to

abide by the terms of this Agreement.  Subject to these restrictions, you may make as many copies of the software as you

need for archival use; for the sole purpose of backing up the software and protecting your investment from loss, as long as

the archival copy contains the same proprietary notices as appear in the original copy of the software.

3. Termination- This Agreement is effective until terminated.  This Agreement (including the above license) will terminate

automatically, without notice from Summitsoft Corporation, if you fail to comply with any provisions of this Agreement.  Upon

termination you must destroy all copies of the software.

4. Limited Warranty/Remedy- Summitsoft Corporation warrants that the CD-Roms on which the software is furnished shall,

for a period of thirty (30) days from delivery (the “Warranty Period”) be free, in normal use, from defects in material and

workmanship.  Summitsoft Corporation will have no responsibility to replace any CD-Roms that have been damaged by

accident, abuse, or misapplication.  If, during the Warranty Period, a defect in the CD-Roms appears, you may return the CD-

Roms to Summitsoft Corporation for repair, replacement or, if so elected by Summitsoft Corporation, refund of your purchase

price.  THE FOREGOING CONSTITUTES YOUR SOLE AND EXCLUSIVE REMEDY UNDER THIS AGREEMENT.  Summitsoft

Corporation does not warrant the completeness or accuracy of any information contained in the software, nor that the use of

the software will meet your needs, nor that its use will be uninterrupted or error free.  EXCEPT FOR THE WARRANTY SET

FORTH ABOVE, THE PRODUCT IS LICENSED “AS IS,” AND SUMMITSOFT CORPORATION DISCLAIMS ANY AND ALL OTHER

WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY IMPLIED WARRANTIES OF

MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT.  No Summitsoft Corporation

dealer, distributor, agent or employee is authorized to make any modification or addition to the foregoing warranty.  Some

states do not allow the exclusion of implied warranties or limitations on how long an implied warranty may last, so the above

limitations and exclusions may not apply to you.  This warranty gives you the specific legal rights, and you may also have

other rights, which vary from state to state.  

5. Limitation of Liability- Under no circumstances shall Summitsoft Corporation be liable to you on account of any claim

(whether based upon principles of contract, warranty, negligence or other tort, breach of any statutory duty, principles of

indemnity, the failure of any limited remedy to achieve its essential purpose, or otherwise) for any special consequential,

incidental, or exemplary damages, including but not limited to lost profits, or for any damages or sums paid by you to third

parties, even if Summitsoft Corporation has been advised of the possibility of such damages.

6. Governing Law- This Agreement shall be governed by and construed in accordance with the laws of the State of Nebraska.

You consent to the exclusive jurisdiction of the state and federal courts located in Omaha, Douglas County, Nebraska, United

States of America for any and all disputes related to this Agreement.  

Summitsoft Corporation License Agreement

2 About Font Management System

Why Font Management System?
If you intend to have more than just a handful of fonts that comes with Windows, You need Font
Management System. Why? For various important reasons. It could seriously affect the system
performance if you have more than 500 fonts in your Fonts Folder.Font Management System optimizes
the performance of your computer by giving you the choice to activate fonts as per your usage. It also
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helps you install, manage, organize and preview fonts effortlessly. Learn more about the features that
let you take control of your Fonts.

Drive Performance
Font Management System optimizes your computer performance by activating your fonts as per your
requirement. Font Management System also prevents system failure due to corrupt, duplicate or
incorrectly installed Fonts.  

Organize
You can organize your fonts based on your usage. Lets say you use a specific set of fonts for a
particular project and another for a different project. You can easily group and organize fonts with
Summitsoft's Font Management System - A great solution especially for designers and professionals.

Different formats - One Font Manager
You can now manage different Font formats including Postscript, TrueType and OpenType with Font
Management System. 

Preview Fonts
Font Management System lets you preview your fonts before you decide which one to use for your next
project. And what's more - You can preview the fonts before you even install them!

Backup and Restore Fonts
Font Management System helps you create a backup of your fonts and restore it whenever you want
to. This is a great solution if you have rare fonts and you want to create a backup to protect them.

Learn More about

System Requirements
Registering and Updating
Getting Help
Installing Font Management System
Getting Started

2.1 System Requirements

System Requirements
For smooth functioning of Summitsoft's Font Management System, we recommend that your computer
meets the following minimum system requirements. 

Hardware: PC with Pentium 233 MHz or higher processor

Operating System: Microsoft Windows® 98SE, Windows ME, Windows 2000, or Windows XP.

Memory: 256 MB of RAM
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Hard Disk: 4 MB of available hard-disk space for Font Management System

CD-ROM or DVD-ROM: CD-ROM drive

2.2 Registering and Updating

Register Online
You can Register and Activate your Summitsoft's Font Management System by visiting our Website.
Once you Register and Activate your product you can have access to the information about our latest
products and updates.

You can register online by visiting the following URL:

http://www.summitsoft.com/register.asp 

Alternatively you can register from the Help Menu on the Menu Bar located at the top of the Font
Management System window.

Updates
You can check for the latest updates available for our products by visiting our Website. If listed you can
download the latest updates for your Summitsoft products from here.

Visit the following URL to Check for Updates:

http://www.summitsoft.com/updates.asp

Another way to Update your Font Management System is to Click the 'Check for Updates' option on
the Help Menu.
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2.3 Getting Help

How to Get Help
To learn more about Summitsoft's Font Management System, click on any of the help file topics in the

list of topics at the left. Click on any of the book ( ) icons to see the topics listed below it; click on

any of the page ( ) icons to display the topic associated with that page in this window. You can also
select one of the browse sequences from the drop down list above and move through the topics by
clicking the Previous and Next buttons or by clicking one of the topics in the graphic browse sequence
in the upper right

Accessing the Help File
You can access the Font Management System Help through the Help Menu on top of the Font
Management System Main Window or by pressing F1 shortcut key.

3 Installation and Setup

3.1 Installing

Installing and Setting up Summitsoft's Font Management System

1. Insert the CD-ROM in the drive and wait for Auto-Run to come up.  If you have auto-run disabled,
then you can go to My Computer and Double-click on your CD-ROM drive icon.  Depending on how
your computer is configured, the auto-run may start.  If the auto-run does not start, then the CD-
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ROM will open and you can double-click on Auto-Run.exe icon to start the Auto-Run program.

2. Once the Auto-Run dialog opens, you can click on the Install button to start the installation.  

3. Once the installation is completed, click Finish at the end and double-click the Font Installer icon on
your Desktop to start the program.

4. Before starting, the Font Management System automatically backs up your existing fonts installed
on your computer. 

3.2 Uninstalling

Uninstalling
If you wish to uninstall Font Management System from your computer you can perform the uninstall
operation from the Add/Remove Programs option in Windows Control Panel.

 
1. Go to Start Menu 

2. Select Settings -> Control Panel -> Add/Remove  Programs 

3. Select Font Management System from the list of Programs  

4. Click on Remove button 

5. Follow the onscreen uninstall instructions 

 

4 Interface Overview

The Interface
Font Management System truly excels with its intuitive interface design. Font preview and Navigation is
extremely user-friendly and efficient. The Main Window is divided in to three Panes - Fonts, Multiple
Preview and Sample Text pane. These three panes feature tabs like Installed Fonts, Browse,
Collections andWorklist that let you easily navigate the options for managing your Fonts. Font
Management System features excellent On Screen Preview for the fonts stored in different folders
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including your default font folder.

Learn More about

Launching and Exiting Font Management System
Menubar Options
Main Toolbar
Character Table Toolbar
Status Bar
Preview Panes and Tabs
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4.1 Launching and Exiting

Launching Font Management System
Once you install Summitsoft's Font Management System you can find the shortcut icon on your
desktop. You can start the program by double-clicking this icon.

 

Exiting Font Management System
Click the Red X at top of the main application window to close the application. You can also exit Font
Management System by clicking the File menu and selecting Exit.

4.2 Menubar Options

Menubar
The menu bar displays commands for performing tasks. Menus are organized by topic and include
File, Edit, View, Font, Tools and Help. 
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File Menu
File menu allows you to setup your printer, preview and print fonts. You can open a previously saved
Worklist and add a New Collection of fonts to the Collections folder from here.

Edit Menu
Edit menu features all the editing options like Cut, Copy, Paste, Delete, Select All and Invert Select
options for editing your fonts. 

View Menu
The View Menu gives you options to display the toolbars like Main Toolbar, Character Table Toolbar
and Status Bar. It allows you to display the tabs like Installed Fonts, Browse, Worklist, Collections,
Character Table, Multiple, Font Properties and Sample Font Text. In addition, you can Temporarily
Activate fonts, Refresh or Apply the Default settings from the View Menu.
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Font Menu
Font menu lets you Install/Uninstall Font(s), Print the Font(s), View Font Properties and  Delete the
Font(s) from the folder.

Tools Menu
Tools menu contains options to Search for Fonts, Explore the Fonts Folder and Export Font
Information to an output folder.
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Help Menu
You can access resources like Help Topics, Summitsoft Website, Online Registration, Updates, Tips
and More information about Font Management System from the Help menu.

4.3 Main Toolbar

The Main Toolbar
The Main Toolbar is located just below the Menubar in the Font Management System Interface. It
features buttons including Installed Fonts, Browse, Worklist, Collections, Font Properties, Sample
Text, Install Font, Uninstall Font, Print, Print All and Temporarily Activate. The function of each button
is outlined below.

Click on the Installed Fonts menu on the Main Toolbar to view the Fonts
installed in your computer.
Click on Browse to locate the Fonts stored in different Folders in your Hard
drive.
Click on Worklist to open the Worklist window where you can work with Fonts,
Edit them and Save your Worklist for future use.
'Collections' lets you display the Font Collections organized in to different
groups.

Click on 'Font properties' to open the properties of the selected Font.

Click on 'Sample Text' to Preview, Edit or Copy the Sample Text for the
Selected Font in the Font Pane.

Click on the Install Font button to Install a new font.

Click on the Uninstall Font button to Uninstall an existing font from the
computer.

Click on Print button to take a printout of the selected Font.

Click on Print All to take a printout of all the Fonts.

Temporarily Activate button when clicked temporarily activates the Fonts and
makes it ready to use.
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4.4 Character Table Toolbar

Character Table Toolbar
The Character Table Toolbar features options to modify Font display settings for the Character Table
located on the Multiple Preview Pane. Make sure you click on the Character table tab on the Multiple
Preview Pane and open Character table before you use this toolbar. Also, the Character Table Toolbar
includes additional buttons for Backing up and Restoring the installed fonts. There are three sets of
tools in the Character table used for specific purposes discussed below. 

The first set of tools in the Character Table Toolbar gives you options to modify the basic attributes of
the Fonts listed inside the Character Table. Using these tools you can select specific set of Fonts,
Change the Size of the Fonts, Change its attributes (Bold, Italics, Underline, Superscript), Zoom in and
Zoom out and preview it in the Character Table Window.

The second set of tools are meant for changing the display settings of the Fonts in the Character
Table. You can change the Font Color, Background Color and Preview Text Color from here. 

The third set of tools let you Backup your Installed Fonts or Restore it from a previously created
backup.

4.5 Status Bar

The Status Bar

The Status Bar located at the extreme bottom of the Font Management System Window displays
general settings like Date and Time, Keyboard Preferences (CAPS Lock On/Off, Number Lock On/Off,
Scroll Lock On/Off and Insert Lock On/Off) and status details - Total number of Installed Fonts, Font
Selected and Total number of Active Fonts. 

Date and Time

Keyboard Preferences
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Font Status

4.6 Preview Panes and Tabs

More about Panes and Tabs
The Panes and Tabs play an important role to maximize effective navigation inside the Font
Management System. There are three Panes and nine different tabs in the Font Management System
which are shown in the screenshot below. Navigation through these Panes and tabs and their common
functions are explained in detail in the upcoming topics.
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Title bar icons on Fonts, Multiple Preview, Sample Text Panes

A stick pin button when upright, the pane is fixed and will not move. When they are laying
down you can expand the pane. The Font pane opens up in Sticky mode and will be fixed
unless you toggle the stick pin button to non-sticky mode.

A Collapse/Expand button lets you to collapse or expand the Panes.

The Close button lets you close the pane.

Related Topics
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Fonts Pane
Multiple Preview Pane
Sample Text Pane
Working with Fonts

4.6.1 Fonts Pane

The Fonts Pane is located on the Left side of the Font Management System Interface. This pane
features five different tabs - Installed Fonts, Summitsoft CD, Browse, Collections and Worklist. Each of
these tabs provide options to locate and preview fonts stored in different folders in your computer. 

Installed Fonts Tab
Click on the Installed Fonts tab to display the list of Installed Fonts in the Fonts pane. It lists down the
Fonts with its basic properties in alphabetic order. 

Summitsoft CD Tab
This tab will only be active if you have inserted any of the Summitsoft Font collection CDs in the CD
Drive. Once you click on this tab it displays the entire set of Fonts available in the Summitsoft CD
listed in alphabetic order.

Browse Tab
This Tab is used to browse for Fonts that are stored in a particular folder or a location on your hard
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drive. Once you locate the Fonts folder click on it to display the Fonts inside the Fonts Pane.

Collections Tab
Collections Tab opens the tree view of different font folders organized in to groups containing specific
fonts. This is usually useful if you wish to use a particular set of fonts for one project and a different set
for the other. You can organize them in to different group folders under the My Font Collection Folder. 

Worklist Tab
The Worklist tab features the basic options add and edit fonts to a Worklist before you install or use
them. You can preview the fonts, save the Worklist or you can install/uninstall the fonts from here. 

4.6.2 Multiple Preview Pane

Multiple Pane is located on the right side of the Font Management System Interface. It provides two
important options for previewing Fonts - Multiple tab and the Character Table tab. 

Multiple Tab
The Multiple Tab lists the Name of the Font and a quick preview of the alphabet in Uppercase,
Lowercase or both. Once you select a particular font in the Font Pane, the Multiple tabbed pane
automatically highlights the corresponding font which makes it the quickest method to preview fonts.

Character Table Tab
Character Table shows the entire list of Characters available for the selected font from the Fonts Pane.
You can click on the character and hold the mouse button down to get a larger display and to get more
details about it. 
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4.6.3 Sample Text Pane

Sample Text Pane is located at the bottom right corner just below the Multiple Pane in the Font
Management System Interface. The Sample text Pane contains two tabs - Sample Text and Font
Properties. 

Sample Text Tab
As the name suggests Sample Text Tab displays a Sample text of the selected Font and provides
options to format it. It features a list of text samples included for your convenience to have a better
Preview of the Font. Additionally you have the Zoom In button to zoom the text and have a closer look
at it.

Font Properties Tab
The Font Properties Tab opens and lists the advanced properties for the selected Font inside the
Sample Text Pane. You can view the properties that is organized in to four categories - Name,
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Properties, Metrics and Advanced. 

5 Working with Fonts

Managing Fonts
Fonts are one of the major components that you cant live without, be it for any project. As ever, many
users have identified the fact that they can double their creativity using a bigger font collection. However
if you don't have a Font Manager, saving too many fonts to your system folder can slow your computer
down drastically. With Font Management System you can Install and Organize your Fonts the right
way. Font Management System is an effective solution for Managing Fonts in your computer with
options to Install, Uninstall, Backup and Restore your Fonts. 

Installing Fonts
To install a font first locate it using the Browse Tab or the Worklist Tab in the Fonts Pane. Once you
locate the font there are many ways to Install it. Learn more

Uninstalling Fonts 
To uninstall a font first locate it using the Browse Tab or the Worklist Tab in the Fonts Pane. Once you
locate the font there are many ways to Uninstall it. Learn more

Backing Up Fonts
When you install Font Management System it takes an automatic backup of your installed Fonts. You
can take  a backup of your Fonts any time using the Backup Installed Fonts option on the Character
Table Toolbar. Learn more

Restoring Fonts
You can restore Fonts from a previous backup using the Restore button located on the Character Table
Toolbar. Learn more

5.1 Installing Fonts

Install a Font
Before you install a font you have to locate it in the Fonts Pane. You can browse for Fonts that needs
to be installed from two different tabs on the Fonts Pane - Browse Tab and Worklist Tab. These Tabs
offer different options to Install the Fonts. 

Installing the Fonts using Browse Tab
Browse Tab gives you a tree view of your windows folders and allows you to locate the Fonts stored
inside any of them. Once you locate the Font using the Browse Tab you can install it in many ways:

1. Highlight the Font that you wish to Install and Click on Install Font Button on the Main
Toolbar
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2. Highlight the Font that you wish to Install and Click on Install Font option through the Font
Menu on the Menubar.

3. Right-click the Font that you wish to Install and Click on Install.
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5.2 Uninstalling Fonts

Uninstalling Fonts from the Fonts Folder
To uninstall fonts make sure you click on the Installed Fonts Tab on the Font Pane to list down the
Installed Fonts. Once you locate the Font you wish to uninstall you can uninstall it in many ways:

1. Highlight the Font that you wish to Uninstall and Click on 'Uninstall Font' button on the Main
Toolbar.
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2. Highlight the Font that you wish to Uninstall and Click on 'Uninstall Font' option through the
Font Menu on the Menubar.

3. Right-click the Font that you wish to Uninstall and Click on 'Uninstall'.
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5.3 Backing up and Restoring

Backing up Fonts
Font Management System allows you to create Backups of your installed Fonts. Click on the Backup
Installed Fonts button on the Character Table Toolbar to create a backup. 

The backed up fonts will be saved in the 'Backup Folder' under the Font Management System program
folder.
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Restoring Fonts
To restore fonts from a previously created backup click on the 'Restore Font' button on the Character
Table Toolbar.

The Fonts will be restored from the Backup to the default Fonts Folder in your hard drive.

5.4 Browsing Fonts

Browsing Fonts
As discussed in the previous chapters installing more than 500 fonts in to the default Windows Fonts
Folder would seriously affect your system performance. Therefore, it is always recommended to
organize your fonts in a different location using the Font Management System. Font Management
System gives you preferences to browse and locate Fonts stored in your computer. If you have
purchased the Summitsoft Font Collection CD you can access up to 2500 Fonts in the Font
Management System without consuming high system resources. In addition, the Worklist option is
integrated to the software to allow you to preview, format fonts and save it for future use. 

Learn More about browsing:

Installed Fonts
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Summitsoft Fonts

Other Windows Folders

Font Collections

Worklist

5.4.1 Installed Fonts

Click on the Installed Fonts tab to display the list of Fonts installed in your computer. Once you have it
open,  you can view different details like Font Name, Family Name, Font Style, Font Type, File Size,
File Name, Weight, Width, Script and the ID.

You can select the font(s) listed here and right click on them for more options. It is the best way to
perform an Uninstall, or to Add them to the Worklist/Font Collections or even Export Font Information
as an HTML file. 
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5.4.2 Summitsoft Fonts

The Summitsoft Tab will only be active if you insert a Font Collection CD that comes from Summitsoft.
The Summitsoft Font Collection CD is a great solution for using more fonts while ensuring your
computer performance is unaffected.

Apart from general preferences like Install/Uninstall and Add to Worklist/Collection options it also
allows you to temporarily activate font(s). 
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5.4.3 Windows Folders

Using the Browse Tab, you can access external fonts like the ones that were downloaded from the
internet and saved in to your local windows folders. Browse Tab gives you a tree view of the folders in
your local hard drive and the window below displays the Fonts inside those folders. 
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Click on Cut button to move a Font
Click on Copy button to copy a Font
Click on Paste button to paste a Font in to the Worklist
Click on Delete button to delete a Font from the Worklist
Click on Go back button to go back to Uninstalled Folder

Once you locate the fonts here you can right click them to perform a variety of tasks like:

Install/Uninstall
You can Install and Uninstall a particular Font using this option.

Install/Uninstall Fonts
This option allows you Install or Uninstall multiple fonts. Please make sure you select all the fonts you
wish to Install/Uninstall before you perform this task.

Temporarily Activate
This option will help you to activate font(s) temporarily. This is useful if you wish to use a particular font
for your project without installing them on to your computer.

Add to Worklist
This is the best option to hand pick certain fonts from a huge list of downloaded fonts. You can add
them to a Worklist add more, delete or save them for future use. 

Add to Collection
You can select and add fonts to an existing group under your Font Collection. 
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Export as HTML
This option lets you export system fonts or selected fonts as a Webpage (HTML), Rich Text Format
(RTF) or as a Text (TXT) file.

Standard Options
Apart from the above mentioned options you can Cut, Copy, Paste or Delete Fonts.

5.4.4 Font Collections

Most of us have a hard time remembering the fonts used in our previous projects. Moreover, searching
for them in the huge list of fonts might be a cumbersome process. That's where the Font Collections
option comes for your help. Font collections option can organize your Fonts in to different directories
that easily accessible. You can create folders and name them based on the project you are working
on. The Font Collections Tabbed Pane gives you a tree view of your Font directories which makes your
work easier with a great preview option.  
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To install Fonts click on the Install button
To uninstall Fonts click on the Uninstall button
Click on Cut button to move a Font
Click on Copy button to copy a Font
Click on Paste button to paste a Font in to the Worklist
Click on Delete button to delete a Font from the Worklist
Click on New Collection button to create a New Collection
Click on Refresh button to refresh the window

Once you have added the fonts here you can right click them to perform a variety of tasks
like:

Install/Uninstall
You can Install and Uninstall a particular Font using this option.

Install/Uninstall Fonts
This option allows you Install or Uninstall multiple fonts. Please make sure you select all the fonts you
wish to Install/Uninstall before you perform this task.
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Temporarily Activate
This option will help you to activate font(s) temporarily. This is useful if you wish to use a particular font
for your project without installing them on to your computer.

Add to Worklist
This is the best option to hand pick certain fonts from a huge list of downloaded fonts. You can add
them to a Worklist add more, delete or save them for future use. 

Add to Collection
You can select and add fonts to an existing group under your Font Collection. 

Export as HTML
This option lets you export system fonts or selected fonts as a Webpage (HTML), Rich Text Format
(RTF) or as a Text (TXT) file.

Standard Options
Apart from the above mentioned options you can Cut, Copy, Paste, Delete Fonts. You can also
Rename, Refresh the Font Collection folders and view the Properties from here.

5.4.5 Worklist

Worklist is a great solution to work with fonts before you save, install or organize them in your
Computer. The Worklist lets you to add fonts, preview them and decide if you wish to keep them or not.
If you would like to install them you can do so or you can activate it temporarily. It is always
recommended to use this option to preview fonts before you install them. You can create multiple
worklists save them and use it later.  
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To add Font(s) to the  Worklist click on the Add button 
To open a saved Worklist Click on the Open Worklist button
To save a Worklist, Click on the Save button 
To remove a Font from the Worklist, Click Remove button
Click on Cut button to move a Font
Click on Copy button to copy a Font
Click on Paste button to paste a Font in to the Worklist
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Click on Delete button to delete a Font from the Worklist

Once you have added the fonts here you can right click them to perform a variety of tasks
like:

Install/Uninstall
You can Install and Uninstall a particular Font using this option.

Install/Uninstall Fonts
This option allows you Install or Uninstall multiple fonts. Please make sure you select all the fonts you
wish to Install/Uninstall before you perform this task.

Temporarily Activate
This option will help you to activate font(s) temporarily. This is useful if you wish to use a particular font
for your project without installing them on to your computer.

Add to Worklist
This is the best option to hand pick certain fonts from a huge list of downloaded fonts. You can add
them to a Worklist add more, delete or save them for future use. 

Add to Collection
You can select and add fonts to an existing group under your Font Collection. 

Export as HTML
This option lets you export system fonts or selected fonts as a Webpage (HTML), Rich Text Format
(RTF) or as a Text (TXT) file.

Standard Options
Apart from the above mentioned options you can Cut, Copy, Paste or Delete Fonts.
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6 Tools

Useful Tools
Imagine having a huge list of fonts in your computer and you want to locate a particular font in it. Font
Management System gives you useful tools like Search Fonts, Explore Fonts Folder and Export Font
Information. Using these tools, you can search for a font or open your Fonts Folder with just a click of a
button or using shortcut keys. You can even export your font information to a Webpage (HTML), Rich
Text Format (RTF) or Text (TXT) file. 

Related Topics

Searching for Fonts

Exploring Fonts Folder

Exporting Font Information

Printing Fonts

6.1 Search Fonts

To Search for fonts click on the Search Fonts option under the Tools Menu. The Shortcut Key for Font
Search is Ctrl + F. You can search for any particular font that is installed or saved in your computer.
Search Window features a Search Pane that lets you search for Fonts by specifying its name and
type.
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Search Results
Once the Search is complete the Results are displayed on the right side. 

Save to File
Once the results are displayed you have the option to save them to a file to view them later. To save
the search file click on Save to File button on the Search Toolbar.
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Status Bar
The search status is displayed on the status bar located at the extreme bottom of the window

6.2 Explore Fonts Folder

Explore Fonts Folder option is an excellent alternative to the traditional approach of opening and
exploring your default windows Fonts Folder. Explore Fonts Folder displays the Windows Font Folder
with just a click of a button. The Shortcut Key for this function is F6.

6.3 Export Font Information

This option lets you export all system fonts or selected fonts as a Webpage (HTML), Rich Text Format
(RTF) or as a Text (TXT) file. The following graphic gives you more details on how to perform this task.
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6.4 Print Options

You can print your font(s) using the Print option, which is easily accessible from the File Menu. Font
Management System gives you options to print a selected font or all the fonts. Before you can start the
print job make sure you have the right settings in the Print Setup. Click on the Print Setup option in
the Font Menu to configure your print settings.
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To Print a selected font click on the Print Font option under the File/Font menu. The Shortcut Key for
this function is Ctrl + P.

Print from File Menu

  

Print from Font Menu

To Print all the fonts click on the Print All option under the Font menu.
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You can also preview your print by accessing the Print Preview option under the File menu. 

7 Getting Support

Support Information
Visit Summitsoft Support Center to get answers to any questions, suggestions or comments related to
our Company and its Products. More information regarding the latest downloads, product updates or
tech support related issues are made available for you through the Support Menu on our Corporate
Website.

Also see

Technical Support

Related Products
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7.1 Technical Support

Avail personalized Technical Support for your product from the Summitsoft Support Center website.
You can Open tickets for assistance, Browse Knowledge-base, Check your ticket history and Manage
your account preferences from Support Center.  The Knowledge-base is a best place to find answers to
your questions and get articles for various topics. 

 
Visit Summitsoft Support Center Now

 
You can also email us for any support related queries, suggestions or feedback to:

Support@SummitsoftCorp.com

 

7.2 Related Products

2500 TrueType Fonts

2500 TrueType Fonts lets you add creative style to scrapbooks, logos, greeting cards, brochures,
invitations & other eye-catching print projects...

Logo Design Studio
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Logo Design Studio gives you the power to create professional logos without paying for a limited
number of concepts from an overpriced design firm.

Ultimate 3D Fonts

Ultimate Fonts is the perfect tool to give your creative projects an eye-catching look. Use any of the
1500 high quality TrueType fonts to easily turn them into three-dimensional works of art!

Essential Office Font Pack 2 

Essential Office Font Pack 2 offers you the widest collection of the most eye-catching fonts. Its an
invaluable asset in both your professional applications and creative pursuits. Select from 1000 of the
most varied fonts used by professionals or 1000 creative fonts artistically designed to add sparkle to
your creative endeavors.
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Commercial Use Font Four Pack 

The Commercial Use Font Four Pack offers everything creative users need to enhance the visual
impact of their text with commercial use fonts that are royalty free. This collection bundles all four
highly successful individual font packs into one convenient download. 

Stationery Design Studio 

Gain confidence by placing a professionally printed identity into the hands of others using matching
business stationery. Carefully designed stationery templates, that include business cards, business
templates, letterheads and envelopes, send the right message to others and help develop your
business image and build professional relationships. 

8 System Fonts

System Fonts are critical components of your computer used by different Programs including the
Windows Operating System. You should to be extremely cautious while working with them. Removing
or uninstalling them might make the system unstable. It is always a good practice to backup the
system fonts for easy recovery in case of an accidental deletion. The upcoming topics outline the
important system fonts used by specific operating systems for your reference. It is highly
recommended NOT TO UNINSTALL any of the fonts listed here.   

List of System Fonts for Windows
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Windows 3.11

Windows 95

Windows 98

Windows NT

Windows 2000/XP

Other System Fonts

8.1 Windows 3.11

System Fonts for Windows 3.11
DO NOT REMOVE these System Fonts from your computer. These fonts are in use by different
programs and the Operating System. You might also have Other System Fonts that are not listed here
but in use by specific programs and should not be removed. To get more details about Other System
Fonts used by specific programs visit http://www.microsoft.com/typography/fonts/default.aspx

DO NOT REMOVE

Arial 

Arial Bold 

Arial Bold Italic 

Arial Italic 

Courier New 

Courier New Bold 

Courier New Bold Italic 

Courier New Italic 

Symbol 

Times New Roman 

Times New Roman Bold 

Times New Roman Bold Italic 

Times New Roman Italic 

Wingdings 

8.2 Windows 95

System Fonts for Windows 95
DO NOT REMOVE these System Fonts from your computer. These fonts are in use by different
programs and the Operating System. You might also have Other System Fonts that are not listed here
but in use by specific programs and should not be removed. To get more details about Other System
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Fonts used by specific programs visit http://www.microsoft.com/typography/fonts/default.aspx

DO NOT REMOVE

Arial 

Arial Bold 

Arial Bold Italic 

Arial Italic 

Comic Sans MS 

Comic Sans MS Bold 

Courier New 

Courier New Bold 

Courier New Bold Italic 

Courier New Italic 

Marlett 

Symbol 

Times New Roman 

Times New Roman Bold 

Times New Roman Bold Italic 

Times New Roman Italic 

Wingdings 

8.3 Windows 98

System Fonts for Windows 98
DO NOT REMOVE these System Fonts from your computer. These fonts are in use by different
programs and the Operating System. You might also have Other System Fonts that are not listed here
but in use by specific programs and should not be removed. To get more details about Other System
Fonts used by specific programs visit http://www.microsoft.com/typography/fonts/default.aspx

DO NOT REMOVE

Abadi MT Cond Light 

Arial 

Arial Black 

Arial Bold 

Arial Bold Italic 

Arial Italic 

Book Antiqua 

Book Antiqua Bold 

Book Antiqua Bold Italic 

Book Antiqua Italic 

Calisto MT 

Century Gothic 

Comic Sans MS 

Comic Sans MS Bold 

Copperplate Gothic Bold 

Copperplate Gothic Light 

Courier New 

Courier New Bold 

Courier New Bold Italic 

Courier New Italic 

Impact 

Lucida Console 

Lucida Handwriting Italic 

Lucida Sans Italic 

News Gothic MT Bold

News Gothic MT Italic 

OCR A Extended 

Symbol 

Tahoma 

Tahoma Bold 

Times New Roman 

Times New Roman Bold 

Times New Roman Italic 

Verdana 

Verdana Bold 

Verdana Bold Italic 
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Century Gothic Bold 

Century Gothic Bold Italic 

Century Gothic Italic 

 

Lucida Sans Unicode 

Marlett 

News Gothic MT 

Verdana Italic 

Webdings 

Westminster 

Wingdings 

8.4 Windows NT

System Fonts for Windows NT
DO NOT REMOVE these System Fonts from your computer. These fonts are in use by different
programs and the Operating System. You might also have Other System Fonts that are not listed here
but in use by specific programs and should not be removed. To get more details about Other System
Fonts used by specific programs visit http://www.microsoft.com/typography/fonts/default.aspx

DO NOT REMOVE

Arial 

Arial Bold 

Arial Bold Italic 

Arial Italic 

Courier New 

Courier New Bold 

Courier New Bold Italic 

Courier New Italic 

Lucida Console 

Lucida Sans Unicode 

Marlett 

Symbol 

Times New Roman 

Times New Roman Bold 

Times New Roman Bold Italic 

Times New Roman Italic 

Verdana 

Verdana Bold 

Verdana Bold Italic 

Verdana Italic 

Wingdings 
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8.5 Windows 2000/XP

System Fonts for Windows 2000/XP
DO NOT REMOVE these System Fonts from your computer. These fonts are in use by different
programs and the Operating System. You might also have Other System Fonts that are not listed here
but in use by specific programs and should not be removed. To get more details about Other System
Fonts used by specific programs visit http://www.microsoft.com/typography/fonts/default.aspx

DO NOT REMOVE

Aharoni Bold 

Andalus 

Angsana New 

Angsana New Bold 

Angsana New Bold Italic 

Angsana New Italic 

AngsanaUPC 

AngsanaUPC Bold 

AngsanaUPC Bold Italic 

AngsanaUPC Italic 

Arabic Transparent 

Arabic Transparent Bold 

Arial 

Arial Black 

Arial Bold 

Arial Bold Italic 

Arial Italic 

Batang 

Browallia New 

Browallia New Bold 

Browallia New Bold Italic 

Browallia New Italic 

BrowalliaUPC 

BrowalliaUPC Bold 

BrowalliaUPC Bold Italic 

BrowalliaUPC Italic 

Comic Sans MS 

Comic Sans MS Bold 

Cordia New 

Cordia New Bold 

Cordia New Bold Italic 

Cordia New Italic 

CordiaUPC 

CordiaUPC Bold 

CordiaUPC Bold Italic 

CordiaUPC Italic 

Courier New 

Courier New Bold 

Courier New Bold Italic 

Courier New Italic 

DFKai-SB (XP) 

David 

David Bold 

David Transparent 

DilleniaUPC 

DilleniaUPC Bold 

DilleniaUPC Bold Italic 

DilleniaUPC Italic 

Estrangelo Edessa (XP) 

EucrosiaUPC 

EucrosiaUPC Bold 

EucrosiaUPC Bold Italic 

EucrosiaUPC Italic 

FangSong_GB2312 (XP) 

Fixed Miriam Transparent 

Franklin Gothic Medium (XP) 

Franklin Gothic Medium (XP) 

FrankRuehl 

FreesiaUPC 

FreesiaUPC Bold 

FreesiaUPC Bold Italic 

FreesiaUPC Italic 

Gautami (XP) 

Georgia 

Georgia Bold 

Georgia Bold Italic 

Georgia Italic 

Gulim 

Impact 

IrisUPC 

IrisUPC Bold 

IrisUPC Bold Italic 

IrisUPC Italic 

JasmineUPC 

JasmineUPC Bold 

JasmineUPC Bold Italic 

JasmineUPC Italic 

KaiTi_GB2312 (XP) 

KodchiangUPC 

KodchiangUPC Bold 

KodchiangUPC Bold Italic 

KodchiangUPC Italic 

Latha 

Levenim MT 

Levenim MT Bold 

LilyUPC 

LilyUPC Bold 

LilyUPC Bold Italic 

LilyUPC Italic 

Lucida Console 

Lucida Sans Unicode 

Mangal 

Marlett 

Microsoft Sans Serif 

MingLiu 

Miriam 

Miriam Fixed 

Miriam Transparent 

MS Gothic 

MS Mincho 

MV Boli (XP) 

Narkisim 

Palatino Linotype 

Palatino Linotype Bold 

Palatino Linotype Bold Italic 

Palatino Linotype Italic 

Raavi (XP) 

Rod 

Rod Transparent 

Shruti (XP) 

SimHei 

Simplified Arabic 

Simplified Arabic Bold 

Simplified Arabic Fixed 

SimSun 

Sylfaen 

Symbol 

Tahoma 

Tahoma Bold 

Times New Roman 

Times New Roman Bold 

Times New Roman Bold Italic 

Times New Roman Italic 

Traditional Arabic 

Traditional Arabic Bold 

Trebuchet MS 

Trebuchet MS Bold 

Trebuchet MS Bold Italic 

Trebuchet MS Italic 

Tunga (XP) 

Verdana 

Verdana Bold 

Verdana Bold Italic 

Verdana Italic 

Webdings 

Wingdings
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8.6 Other Fonts

You might have Other System Fonts used by specific programs and should not be removed either. If
you remove them the program might become unstable. You can check the list of Other Fonts used by
a particular program at:

http://www.microsoft.com/typography/fonts/default.aspx
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Index
- 1 -
1000     43

1000 creative fonts     43

1500     43

- 2 -
2500     43

2500 Fonts     27

2500 TrueType Fonts     43

256 MB of RAM     7

- 4 -
4 MB     7

- 5 -
500 fonts     27

- 9 -
98SE     7

- A -
access external fonts     30

access resources     12

access to the information     8

Accessing the Help File     9

account preferences     43

activate     6, 8, 34

activate font     30

activate it temporarily     34

add     19

add fonts     32, 34

Add them to the Worklist     28

Add to Collection     30, 32, 34

Add to Worklist     29, 30, 32, 34

Add/Remove     10

Add/Remove  Programs     10

Add/Remove Programs     10

added the fonts     32

Advanced     21

advanced properties     21

alphabet     20

alphabetic order     19

answers to your questions     43

Apply the Default settings     12

automatic backup     22

- B -
backed up fonts     26

Background Color     16

Backing up     16, 26

Backing up Fonts     22, 26

backs up your existing fonts     9

Backup     5, 6, 16, 22, 26

Backup Folder     26

Backup Installed Fonts button     26

basic properties     19

below the Menubar     15

bigger font collection     22

Bold     16

book     9

bottom right corner     21

brochures     43

Browse     10, 12, 15, 19

browse and locate Fonts     27

browse for Fonts     19, 22

Browse Knowledge-base     43

browse sequences     9

Browse Tab     19, 22, 30

Browsing Fonts     27

build professional relationships     43

business cards     43

business templates     43

button     15

buttons     9

- C -
CAPS Lock On/Off     16

CD-ROM     7

CD-ROM drive     7

Change its attributes     16

Change the Size of the Fonts     16
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Character Table     16

Character Table tab     16, 20

Character Table Toolbar     12, 16, 26

Character Table Window     16

Characters     20

Check for Updates     8

clicking     9

close the application     12

collection     29, 43

Collections     10, 12, 15, 19

Collections Tab     19

commands     12

comments     42

Commercial     43

Commercial Use Font Four Pack     43

commercial use fonts     43

common functions     17

Company     42

Computer     7, 34

configure your print settings     40

control of your Fonts     6

Control Panel     10

convenient download     43

Copy     12, 30, 32, 34

Corporate Website     42

corrupt     6

create a backup     6, 26

create Backups     26

create folders     32

created backup     16

creative endeavors     43

creative projects     43

creative users need     43

creativity     22

Ctrl + F     37

Ctrl + P     40

Custom font preview     5

Cut     12, 30, 32, 34

- D -
Date and Time     16

deactivate fonts     6

Delete     12, 30, 32, 34

Delete the Font     12

Design     43

designers     6

designing Online     5

desktop     9, 12

develop your business image     43

different directories     32

different Folders     15

Different formats     6

different groups     15

display     28

display settings     16

display the list     19

display the topic     9

displays     16, 21

download the Font Management System     9

download the latest updates     8

downloaded     9, 30

downloaded fonts     32, 34

Drive Performance     6

drop down list     9

duplicate     6

DVD-ROM     7

- E -
easily accessible     32

easily navigate     10

Easy-to-use interface     5

Edit     12

edit fonts     19

Edit Menu     12

editing your fonts     12

effective Font Manager     6

effective navigation     17

efficient     10

effortlessly     6

email us     43

entire set     19

Essential Office Font Pack 2     43

existing group     32, 34

Exiting     12

Explore     37

Explore Fonts     39

Explore Fonts Folder     37, 39

Explore the Fonts     12

export all system fonts     39

Export as HTML     30, 32, 34

Export Font Information     12, 28, 37, 39

export your font information     37

external fonts     30

eye-catching look     43
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eye-catching print projects     43

- F -
F1 shortcut key     9

F6     39

Family Name     28

features     6

feedback     43

File     12

File menu     12, 40

File Name     28

File Size     28

File/Font menu     40

first set of tools     16

folder     19

folders     30

Font     12

Font Collection     32, 34

Font Collection folders     32, 34

Font Collections     15, 27, 28, 32

Font Collections option     32

Font Collections Tabbed Pane     32

Font Color     16

Font directories     32

Font Folder     39

Font Management     5

Font Management System     6, 9, 10, 12, 15, 19, 20,
21, 27, 37

Font Management System Help     9

Font Management tool     6

Font Manager     6, 22

Font Menu     12, 22, 40

Font Name     28

Font Pane     20, 24

font preview     5, 10

Font Properties     12, 15, 21

Font Properties Tab     21

Font Search     37

Font Selected     16

Font Status     16

Font Style     28

Font Type     28

Fonts     5, 10, 24, 30, 40, 43

Fonts Folder     6, 24, 26

Fonts Pane     19, 22

fonts used     32

format     21

format fonts     27

- G -
general preferences     29

general settings     16

get answers     42

get articles     43

get more details     20

Getting Help     9

graphic     9

great solution     6

greeting cards     43

group     6, 19

- H -
hand pick certain fonts     32, 34

handful of fonts     6

Hard Disk     7

hard drive     15, 26

hard-disk     7

hard-disk space     7

Hardware     7

Help     12

help file topics     9

help me     8

Help Menu     8, 9, 12

Help Topics     12

high quality TrueType fonts     43

high system resources     27

How to Get Help     9

HTML file     28

huge list     37

huge list of fonts     32

- I -
icon     12

icons     9

ID     28

incorrectly installed Fonts     6

individual font packs     43

insert a Font Collection CD     29

Insert Lock On/Off     16

inserted     19

install     6, 19, 22, 34
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Install a Font     22

Install and Organize     22

Install Font     15

Install Font Button     22

install Summitsoft Font Management System     12

Install/Uninstall     19, 29, 30, 32, 34

Install/Uninstall Font     12

Install/Uninstall Fonts     30, 32, 34

installation file     9

installation instructions     9

installed     28

Installed Fonts     10, 12, 15, 16, 19, 24, 26, 27, 28

Installed Fonts tab     19, 24, 28

installing     5, 9, 27

Installing and Setting up     9

Installing Fonts     22

Installing the Fonts     22

Interface     15, 19, 20, 21

Interface Overview     10

internet     30

intuitive interface design     10

Invert Select     12

invitations     43

Italics     16

- K -
key things     5

Keyboard Preferences     16

- L -
larger display     20

latest downloads     42

latest products     8

latest updates     8

Launching     12

Launching and Exiting     12

learn more     9

Left side     19

letterheads and envelopes     43

list of Fonts     28

list of topics     9

local hard drive     30

local windows folders     30

locate     22

locate and preview     19

locate the Font     22

locate the Fonts     15, 19

location on your computer     9

location on your hard drive     19

Logo     43

Logo Design Studio     43

logos     43

Lowercase     20

- M -
Main Toolbar     12, 15, 22, 24

manage     6

manage the fonts     5

Manage your account     43

Managing Fonts     22

managing your Fonts     10

matching business stationery     43

Memory     7

Menubar     12

Menubar Options     12

Metrics     21

Microsoft Windows     7

minimum system requirements     7

modify     16

modify Font display     16

more     6

More information     12

more than 500 fonts     6

mouse button     20

Multiple     12

Multiple Pane     20

Multiple Preview     10

Multiple Preview Pane     16

Multiple tab     20

Multiple tabbed pane     20

multiple worklists     34

My Font Collection     19

- N -
Name     21

name and type     37

Name of the Font     20

navigate     10

Navigation     10

New Collection     12
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Next     9

nine different tabs     17

Number Lock On/Off     16

- O -
On Screen Preview     10

One-click installation     5

Online     5

Online Registration     12

onscreen uninstall instructions     10

open the folder     9

Open tickets     43

open your Fonts Folder     37

OpenType     6

Operating System     7

optimizes the performance     6

options     10

organize     5, 6, 34

organize fonts     6

organize your Fonts     27, 32

organized in to groups     19

Organizing Fonts     5

Other Windows Folders     27

output folder     12

- P -
page     9

Panes     10, 17

particular font     37

particular project     6

Paste     12, 30, 32, 34

PC     7

Pentium 233 MHz     7

performing tasks     12

personalized Technical Support     43

PostScipt     6

preferences     27

prevents system failure     6

preview     6, 12, 16, 27, 32, 40

preview fonts     6, 20, 34

Preview of the Font     21

preview option     32

Preview Panes and Tabs     17

Preview Text     16

Preview Text Color     16

preview the fonts     19

Previous     9

previous backup     22

previous projects     32

previously created backup     26

Print     15

print a selected font     40

Print a selected font click     40

Print All     15

Print All option     40

Print all the fonts     40

Print Font option     40

print fonts     12

print job     40

Print option     40

Print Options     40

Print Preview     40

Print Projects     5

Print Setup     40

Print Setup option     40

Print the Font     12

print your font     40

printed identity     43

processor     7

product updates     42

Products     42

professional logos     43

professionally printed     43

professionals     6, 43

program folder     26

Programs     10

project     19, 22, 32

Properties     21, 32, 34

protect     5, 6

- Q -
questions     42

quick preview     20

quickest method     20

- R -
Red X     12

Refresh     12, 32, 34

Register     8

Register Online     8



Font Management System56

© 2015 Summitsoft Corporation

Registering and Updating     8

related issues     42

Related Products     43

Remove     10

Rename     32, 34

Restore     5, 16

Restore Font     26

restore fonts     5, 6, 26

restore it     6

Restore your Fonts     22

Restoring     26

Restoring Fonts     22, 26

Results     37

Rich Text Format (RTF)     30, 32, 34, 37, 39

right click     28, 30, 32

right side     20, 37

Right-click the Font     22, 24

royalty free     43

- S -
Sample Font Text     12

Sample Text     15, 21

Sample Text Pane     10, 21

Sample Text Tab     21

save     27, 30, 34

Save the Setup     9

save the Worklist     19

save them to a file     37

Save to File     37

Save to File button     37

scrapbooks     43

Script     28

Scroll Lock On/Off     16

Search     37

Search Fonts     37

search for a font     37

search for any particular font     37

Search for Fonts     12

Search Pane     37

Search Results     37

search status     37

Search Toolbar     37

Search Window     37

searching     32

second set of tools     16

Select All     12

select specific     16

selected fonts     39

selecting Exit     12

send the right message     43

seriously affect     6

set of Fonts     5

sets of tools     16

Settings     10

Setup Application     9

setup your printer     12

shortcut icon     12

Shortcut Key     37, 39, 40

shortcut keys     37

slow     22

smooth functioning     7

specific set of fonts     6

Standard Options     30, 32, 34

Start Menu     10

start the program     12

starting the installation     9

Stationery Design Studio     43

stationery templates     43

Status Bar     12, 16, 37

status details     16

Studio     43

suggestions     42, 43

Summitsoft     5, 29

Summitsoft CD     19

Summitsoft CD Tab     19

Summitsoft Corporation     6

Summitsoft Font collection     19
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